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In case of difficulty 
 
Should a fault become apparent in the system, and simple checks have revealed nothing obvious, 
please follow the procedure as laid out by your internal maintenance policy.  It is essential that all 
faults be documented in an appropriate logbook, for any future referencing. 
For any further information, please contact our office during business hours on any of the following 
numbers:  

Phone: 07 3844 1103 
 Fax: 07 3844 1078 
Alternatively, contact us on the Internet: 
 Email: info@jacques.com.au 

Web page: www.jacques.com.au 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
JACQUES ELECTRONICS PTY LTD 
ABN  22 764 519 461 
Copyright © 2002 
The contents of this document may not be reproduced, stored in a retrieval system or transmitted in 
any form by any means; electronic, mechanical, photocopying, recording, or otherwise, without the 
prior written permission of Jacques Electronics Pty Ltd.  Jacques Electronics Pty Ltd reserves the right 
to continually improve products by updating any equipment specifications, document context and 
design styling.  Always quote this manual publication version (found on the front cover), when 
enquiring about any further product information. 
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SECTION 1 – Overview 
 
Introduction 
 
Thank you for purchasing the Jacques Electronics PC Master intercom system. 
Jacques Electronics are committed to providing you with the very latest in networked intercom system 
technology, found with the many features that are available within the PC Master software version 
4.28 
 
This User Manual explains how to operate the PCC-550M GUI software, which controls the Jacques 
Networked Intercom system from the PC Master unit.  It covers all areas of calls 
sending/answering/group calls, etc, however it does not cover any details of operation that is within 
the Setup menu.  The Setup menu is covered in detail in the separate Jacques Technical Operating 
Manual. 
 
Definition of text formatting 
 
! Throughout this manual, the words in italic are Names, or used to show important meaning 

within the text. 
! The words in bold Arial font represent on-screen buttons, main windows and text. 
! The words in normal Arial Font represent on-screen toolbar menus. 
! The words in Bookman Old Style font represent other on-screen text. 
! The term Operator, is the actual Officer In Charge (OIC).  He/she will be using the Jacques 

PC Master software to control and operate the Intercoms, PA Amplifiers and Recording 
equipment.  There can be many Operators per system.   
Generally, there is one Operator for every PC terminal/Level installed. 

! The term PC, is the actual Personal Computer terminal that the Operator uses. 
! The term Master Station, is the actual PC Master.  The Master Controller software, version 

4.28 that is installed and operating correctly.  This controls all calls sent and received on that 
Level. 

! The term Device, can be a JACQUES Slave, PA Amplifier, another Master Unit or an Audio 
Interface unit.  They are the individual hardware, controlled from a JACQUES PC Master 
Unit, to perform a particular task or tasks. 

! Slave units are the individual JACQUES Intercoms, located in walls, doorways and gates.  
They are used by the caller to send and receive intercom calls. 
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SECTION 1 – Overview 
 
JACQUES PCC-550M Master Station 
The JACQUES PCC-550M PC Master Station uses an IBM® compatible personal computer, with 
user-friendly Graphical User Interfaces (GUI's) running on the Windows® operating system.  
It provides full control of all facilities through simple keystrokes or a mouse. 
The PC Master uses the GUI's to allow control of all system functions including audio-only Intercom, 
Audio/Video Intercom, Help Point, Access control, Video surveillance, Multi zone PA and Auxiliary 
Audio channels. 
The JACQUES PCC-550M Master Station includes the following components (refer to FIGURE 1). 

• Personal Computer (PC) 
• Gooseneck microphone 
• Monitor speaker 
• Push-To-Talk (PTT) button 
• Installed JACQUES proprietary PC Master Controller Software 

 
FIGURE 1: Block diagram of a JACQUES PCC-550M PC Master Station. 

 
 
PC Computer requirements 
! Pentium 100 Processor  (Minimum) 
! 16MB RAM  (Minimum) 
! Mouse and keyboard 
! Video Card set to 800 x 600 lines resolution (SVGA mode-1), with 256 colours minimum. 
! No sound card is required 
! No CD ROM is required, as installation is provided on 1.44 floppy disks 
! Windows 95 or 98 operating system installed 
! Jacques PC Master software installed (current version 4.28) 
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SECTION 1 – Overview 
 
Device Identification Codes 
The PCC-550M PC Master displays Identification Codes that are used to represent Devices. 
Devices are attached Intercom Slaves or Accessories that make up the JACQUES Intercom System, 
and are individually controlled by the Master. 
Every JACQUES Device has to be registered within the operating software by means of Identification 
Codes.  These codes are critical for correct Device identification and operation within the Jacques 
intercom system and consist of three different individual codes: 
 

1/  Tag, ranging from 1 to 8191 
A Tag can be described as one of the software address identifier codes, to the rest of the system. 
The Tag is stored inside the EEPROM memory chip, located on the actual Pro Slave PCB or inside the 
Concentrator unit (when using Concentrator Slaves).  Tags can be displayed on the Idle screen, within 
the Selection by: Tag window.  (see next page, FIGURE 2). 
 
Tags are NOT changeable by the Operator and can only be changed by a Technician from the Setup 
menu.  (see separate Jacques Electronics Technical Operating Manual) 
Jacques Electronics determines the Tag number for the Cell Slaves and PA Amplifiers. 
The third-party Security Management System manufacturers (if used) are normally responsible for 
determining the Tag for the Gate and Door Slaves. 
 
Examples of a Tags are: 

223 
6888 

 
2/  Descriptor, of up to 25 characters long 

A Descriptor is another software address identifier code, used to identify the Slave location.  EG: 
Front Gate. 
 
The Descriptor is stored inside the EEPROM memory chip, located on the actual Pro Slave PCB or 
inside the Concentrator unit (when using Concentrator Slaves).  It can be displayed on the Idle screen, 
in the Selection by: Descriptor window.  (see next page, FIGURE 2). 
Descriptors are NOT changeable by the Operator and can only be changed by a Technician from the 
Setup menu.  (see separate Jacques Electronics Technical Operating Manual) 
 
Examples of Descriptors are: 

Front Gate 
R2-B CELL 1 

 
3/  Name, of up to 25 characters long 

The Name is used to logically and easily identify a particular Slave.  EG: Fred Jones 
 
Names are stored inside the PC’s internal registry, not the EEPROM memory chip.   
They can be displayed on the Idle screen, within the Selection by: Name window (see next page, 
FIGURE 2).  Unlike the Tag or Descriptors, the Device Name CAN be changed, or updated, by the 
Operator.  (see: PAGE 26) 
 
Examples of Names are: 

Fred Jones 
Johnny C 
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SECTION 2 – Calling Functions 
 
This Section describes the basic calling functions (Call Send – Call Receive, etc) from the PCC-550M 
Master Station, to other Devices, by using the JACQUES Master Controller program, version 4.28. 
 
 
No calls present 
When no calls are placed from the Slaves, or when no calls are sent from the Master: i.e. There is NO 
calling activity between any Masters to Slaves, or Slaves to Masters, then the Main Screen will 
resemble that of FIGURE 2, operating in the Idle mode. 
The main window on this screen is referred to as the Selection by: …window.  In this window, we 
can see the complete listing of all Slaves and other Masters.  It does not show PA Amplifiers, or other 
Jacques Devices. 
The Selection by: … window can be configured to list the Slaves by its Tag, Descriptor or 
Name.  (see: VIEW - Selection by:... (PAGE 29) 
 
 

FIGURE 2:  No Calls present.  This is the Idle screen  
The actual contents within the Selection by:... window will be different from your screen. 
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SECTION 2 – Calling Functions 
 
Calling a Slave 
There are two ways to send a Call from the PC Master to a Slave: 

1/  From the Idle screen (refer to FIGURE 2, previous page), position the mouse-pointer on 
the Slave you wish to call, listed in the Selection by:… window. 
Double-click the left mouse button on that Slave.  The Slave is now highlighted and the Call is 
now connected.  The screen will look like FIGURE 17, PAGE 18: “Call Connected”. 

 
2/  From the Idle screen (refer to FIGURE 2, previous page), position the mouse-pointer on 
the Slave you wish to call, listed in the Selection by:… window. 
Single-click the left mouse button on that selected Slave (to highlight that Slave) then single-
click the left mouse button on the CONNECT button (see FIGURE 3).  The Call is now 
connected.  The screen will look like FIGURE 17, PAGE 18: “Call Connected”. 

 

FIGURE 3:  The CONNECT button    
 
 
Call Announcing 
See: Call Announcing (PAGE 18) 
 
End a Call 
See: End a Call (PAGE 19) 
 
Calling a Higher-Level Master 
From the Idle screen (refer to FIGURE 2, previous page), position the mouse-pointer on the 
MASTER CALL button (FIGURE 4) and single-click the left mouse button. 
 

FIGURE 4:  The MASTER CALL button    
 
The Higher-Level Master is now being called (but not yet connected). 
The MASTER CALL button changes to CANCEL CALL (FIGURE 5). 
 

FIGURE 5:  The CANCEL CALL button    
 
Single left-click the CANCEL CALL button now, if the Operator decides to cancel the call. 
 
The Operator from the Higher-Level Master can now answer the call. 
When the call is answered, the call is connected.  The CANCEL CALL button then changes to END 
CALL (FIGURE 6).  Both Master Operators can now speak freely into their Microphones, as the call 
is connected in hands-free mode. 
 
Single left-click the END CALL button (FIGURE 6) to disconnect and return to the Idle screen. 
 

   FIGURE 6:  The END CALL button   
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SECTION 2 – Calling Functions 
 
Group Calls 
The Group Call function is available to allow the Operator to make an announcement to the Jacques 
PA Amplifiers or other Devices, over a selected area or Group, of the installation site. 
Groups are the actual selected Devices, combined together to form a Group. 
 
The Operator has the choice to select as many Groups as required from a list of 16 different Groups, 
however the actual configuration of the Groups are NOT changeable by the Operator and can only be 
changed by a Technician from the Setup menu.  (see separate Jacques Electronics Technical 
Operating Manual) 
 
Calling a Group – Group(s) select 
Step 1/ 
To select a single or multiple Group(s), position the mouse-pointer over the GROUPS / PA button 
(FIGURE 7) and single click the left-mouse button.  The screen will now look like that of FIGURE 8. 

FIGURE 7:  The GROUPS / PA button    
 
Step 2/  (Refer to FIGURE 8). 
To select any of these 16 different Groups (there can be multiple Groups selected), position the mouse-
pointer over the “Group xx” textbox, located in the Selected Call Groups window, which 
represents that particular Group to be called and single-click the left mouse button.  This action places 
a tick “!” in that Group box and displays the destination of the group call in the Devices in 
Selected Call Groups window. 
 
The Group(s) have now been selected, the call is ready to be connected. 
See: Connecting a Group Call (PAGE 13) 
 

FIGURE 8:  The Groups selection screen.  In this example, R14 BLOCK has been 
selected, from the Selected Call Groups window and is displayed in the Devices 
in Selected Call Groups window as R14 CELL 17. 
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SECTION 2 – Calling Functions 
 
Calling a Group – Device(s) select 
The Operator can also communicate to only a single specific Device, instead of a Group. 
(This may be required, because a Group may contain several Devices). 
 
An example is when the Operator needs to make an announcement to only a specific area or room, 
which is controlled by a single PA Amplifier and speaker(s).   
In this instance, we only need to enable that specific amplifier (or Device). 
 
 
Selecting a specific JACQUES Device: 
 
Step 1/ 
Position the mouse-pointer over the GROUPS / PA button (FIGURE 7, previous page) and single 
click the left-mouse button.  The screen will now look like that of FIGURE 8 from previous page. 
 
 
Step 2/ (refer to FIGURE 8, previous page) 
Select the Group that the Device is located in, by positioning the mouse-pointer over the “Group xx” 
text, located in the Selected Call Groups window, and single-click the left mouse button. 
This action places a tick “!” in that Group box and displays the actual destination of the group call in 
the Devices in Selected Call Groups window.   
 
Step 3/ 
Finally, select the actual Device from the Group by positioning the mouse-pointer on the required 
Device, (located in the Devices in Selected Groups window FIGURE 8, previous page) and 
single-click the left mouse button. 
This action selects the Device from the Group – the call is now ready to be connected. 
 
For Group call connection, see next page: Connecting a Group Call. 
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SECTION 2 – Calling Functions 
 
Connecting a Group call 
Once the Group(s) or single Device has been selected, the call is then ready to be connected. 
 
There are two ways to connect a Group Call: 

1/  Group(s) select (multiple Devices select). 
From the Groups selection screen (FIGURE 8 PAGE 11), position the mouse-pointer 
on the CALL GROUP button (FIGURE 9) and single-click the left mouse button.  
The screen will now look like FIGURE 11.   
The call is now connected to that Group(s), as confirmed by the title bar (example) 
�Connected to Block B Amp�, displayed along the top of the screen.  
The Operator can now speak – see: Group Announcing (NEXT PAGE). 

FIGURE 9:  The CALL GROUP button    
 

2/  Single Device (single Device select): 
From the Groups selection screen (FIGURE 8 PAGE 11), position the mouse-pointer 
on the CONNECT button (see FIGURE 10) and single-click the left mouse button.  
The screen will now look like FIGURE 11. 
The call is now connected to that Group(s), as confirmed by the title bar (example) 
�Connected to Block B Amp�, displayed along the top of the screen.   
The Operator can now speak – see: Group Announcing (NEXT PAGE). 

FIGURE 10:  The CONNECT button    
 

FIGURE 11:  The Group Call connected screen 
In this example, Block B Amplifier was selected and is now successfully connected,  
ready for the Operator to speak. 
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SECTION 2 – Calling Functions 
 
Group Announcing 
Once the call has been successfully connected, the Operator can now make the announcement. 
 
There are three ways to announce the call:   
 

1/  (Refer to FIGURE 11, previous page) 
Position the mouse-pointer on ANY of the empty white window areas of the Devices in 
Selected Groups window and use the left mouse button as a Push-To-Talk (PTT) button: 
Click and hold the left mouse button, and speak into the Microphone. 

 
2/  (Refer to FIGURE 11, previous page) 
Position the mouse-pointer on the PRESS TO TALK button (FIGURE 12) and use the left 
mouse button as a Push-To-Talk (PTT) button:   
Click and hold the left mouse button, and speak into the Microphone. 

 

FIGURE 12:  The PRESS TO TALK button    
 

3/ 
In some installations, the PC Masters have a separate desk-mounted PTT button located near 
the Microphone.   
Push and hold this button, while talking into the microphone. 

 
 
 
End Group call 
There are two ways to end the Group Call function: 
 

1/  (Refer to FIGURE 11, previous page) 
Position the mouse-pointer on ANY of the empty white window areas of the Devices in 
Selected Groups window and single-click the right mouse button.  The call has now ended. 

 
2/  (Refer to FIGURE 11, previous page) 
Position the mouse-pointer on the END CALL button (FIGURE 13) and single-click the left 
mouse button.   
The call has now ended. 
 

FIGURE 13:  The END CALL button    
 
 
 
Close 
To return to the main Idle screen (FIGURE 2, PAGE 9), position the mouse-pointer on the Close 
button (FIGURE 14) and single-click the left mouse button. 
 

FIGURE 14:  The Close button    
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SECTION 3 – Answer Functions 
 
Incoming Calls 
During an unanswered incoming call, the screen changes to that of FIGURE 15.   
Two windows are present: Selection by: … and Calls Waiting. 
The incoming call is shown inside the Selection by: … window and highlighted in Green with 
“(Waiting)” written beside it.   
Call details are displayed in the Calls Waiting window.   
 
The �Calls Waiting� logo, written along the top of the screen, also flashes (blue to white 
background), along with an audible 2-tone beep from the Operator’s monitor speaker. 
 
The call can now be answered – see: Connecting an Incoming Call (PAGE 17). 
 
 

FIGURE 15:  Unanswered incoming calls.  The Call waiting screen 
The actual contents within the Selection by: � window and the Calls Waiting: 
window will be different from your screen.  
In this example, the Slave R14 Cell 17 is calling this Master. 
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SECTION 3 – Answer Functions 
 

Priority Importance 
All Devices have a Priority Importance number attached to them.  This is provided to create an 
answering order during multiple incoming calls. 
 
The highest priorities of importance are other Master units.  If there is a Master unit calling with other 
Slaves, then that Master will always come up to be answered first, (located at the top of the queue). 
Second levels of importance are the Gate and Door Slaves, followed lastly with the Cell Slaves. 
 
When there are more than one incoming call present, the calls are then automatically listed in order of 
Priority Importance.  
The priority number is recommended to be changed by a Technician from the Setup menu (see 
separate Jacques Electronics Technical Operating Manual), but can also be changed by the Operator 
(see: VIEW – Edit Cell Slaves – Priority, PAGE 26). 
 
 
 
About Third-party Security Management Systems Software 
Jacques Electronics intercom systems can be easily interfaced and used with other (third party) 
Security Management System Software. 
When they are used together and a Gate or Door Slave is calling, then that call can ONLY be 
answered from the other security system software. 
Once the call has been connected from this application, the JACQUES PC Master can then also speak 
and listen to the connected Gate or Door Slave. 
Refer to the manufacturers own software operation manual, for details. 

 



 

Jacques Electronics Pty Ltd  
 

USER MANUAL - JACQUES PCC-550M PC MASTER
  

268 Montague Road, West End 
Queensland, Brisbane, Australia 4101  
Web: http://www.jacques.com.au 

Phone: +61 7 3844 1103 
Fax: +61 7 3844 1078 

Email: jacques@jacques.com.au 
 

17 

SECTION 3 – Answer Functions 
 

Connecting an Incoming Call 
Once a call has been sent from a Slave or Master and the Operator has identified who is calling, that 
Call can now be connected and then answered. 
 
Incoming calls can be connected in one of three ways: 

1/  (refer to FIGURE 15, PAGE 15) 
Position the mouse-pointer on the unanswered call in the Selection by: window.   
Double-click the left mouse button.   
The call is now connected.  The Operator can now listen to that Slave or Master. 

 
2/  (refer to FIGURE 15, PAGE 15) 
Position the mouse-pointer on the unanswered call in the Calls Waiting window.   
Double-click the left mouse button.   
The call is now connected.  The Operator can now listen to that Slave or Master. 

 
Multiple calls that are displayed inside the Calls Waiting window (FIGURE 15, PAGE 15), are 
automatically listed in order of Priority Importance.  That is, most important calls are located at the 
very top of the list, least important calls are at the bottom. 
 

3/  Position the mouse-pointer on the ANSWER NEXT button (FIGURE 16).  Single-click 
the left mouse button.  The first (highest priority) unanswered call is now connected.  The 
Operator can now listen to that Slave or Master. 

 

FIGURE 16:  The ANSWER NEXT button    
 

 
Continue clicking the ANSWER NEXT button, until all unanswered Calls have been answered.  The 
last Call to be answered will have the lowest priority. 
This method will automatically answer the calls (if there are more than one call waiting) in order of 
priority importance and is the preferred way of answering a call. 
 
When the incoming call has been connected, the screen changes to that of FIGURE 17, next page. 
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SECTION 3 – Answer Functions 
 
Connecting an Incoming Call (continued…) 
The connected Slave is highlighted with “(Connected)” written beside it and its Device Descriptor 
Word is displayed along the top of the main screen. 
 
(In this example of FIGURE 17, the Device Descriptor Word is “R14 CELL 17�) 
 

 
FIGURE 17:  The Call connected screen 
In this example, the Slave R14 CELL 17 is connected 

 
 

Call Announcing 
Once the Call is connected, the Operator immediately listens in to that Slave or Master. 
To talk to that Slave or Master, the Operator needs to activate the Push-To-Talk (PTT) button. 
 
There are three ways to talk to the connected calls: 
 

1/  (Refer to FIGURE 17, above) 
Position the mouse-pointer on ANY of the empty white areas of the Selection by: window 
and use the left mouse button as a Push-To-Talk (PTT) button: 
Click and hold the left mouse button, while speaking into the microphone. 
When the PTT switch is activated, the colour of the PUSH TO TALK button changes to Red. 
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SECTION 3 – Answer Functions 
 
Call Announcing (continued…) 

2/ 
Position the mouse-pointer on the PUSH TO TALK button (see FIGURE 18) and use the left 
mouse button as a Push-To-Talk (PTT) button: 
Click and hold the left mouse button, while speaking into the microphone. 
When the PTT switch is activated, the colour of the PUSH TO TALK button changes to Red. 

 

FIGURE 18:  The PUSH TO TALK button    
 

3/ 
In some installations, the PC Masters have a separate desk-mounted PTT button. 
Push and hold this button, while speaking into the microphone. 

 
To revert back to the listen mode at anytime during the conversation, release the PTT speak function 
switch. (Release the mouse button or desk PTT switch). 
 
 
End a Call 
When the Operator has finished the call, it must then be disconnected, or ended. 
Another call cannot be connected until the first Call has been disconnected. 
 
There are three ways to end a call: 

1/  (Refer to FIGURE 17, previous page) 
Position the mouse-pointer on ANY of the of the empty white areas of the Selection by: 
window and single-click the right mouse button.  The call has now been disconnected. 

 
2/  (Refer to FIGURE 17, previous page) 
Position the mouse-pointer on the END CALL button (see FIGURE 19) and single-click the 
left mouse button.  The call has now been disconnected. 

FIGURE 19:  The END CALL button    
 

3/ 
Timed calls: 
The JACQUES software version 4.28 has a feature called timed calls:   
The duration of each call can be set from between 0 (disabled) to 10,000 seconds.  Timed calls 
are not changeable by the Operator and can only be changed by a Technician from the Setup 
menu.  (see separate Jacques Electronics Technical Operating Manual) 
If this feature is enabled, the call will automatically be disconnected after the set time has 
expired. 

 
 

Close 
To return to the main Idle screen (FIGURE 2, PAGE 9), position the mouse-pointer on the Close 
button (see FIGURE 20) and single-click the left mouse button. 
 

FIGURE 20:  The Close button    
 



 

Jacques Electronics Pty Ltd  
 

USER MANUAL - JACQUES PCC-550M PC MASTER
  

268 Montague Road, West End 
Queensland, Brisbane, Australia 4101  
Web: http://www.jacques.com.au 

Phone: +61 7 3844 1103 
Fax: +61 7 3844 1078 

Email: jacques@jacques.com.au 
 

20 

SECTION 4 – Monitor Function 
 
Monitor Function 
The Monitor function allows the Operator to hear (or Monitor) a selected Slave.  This allows the 
Operator to listen-in on any conversations, without otherwise being heard. 
 
Only one Slave can be monitored at a time. 
The Operator can only listen-in on the Slave.  The Slave cannot listen-in on the Operator. 
 
 
Selection 
To begin monitoring, select the correct Slave from the Idle screen (FIGURE 2, PAGE 9): 

 
To select the Slave, position the mouse-pointer on that Slave in the Selection by: … window and 
single-click the left mouse button.  That Slave is now highlighted - ready to be connected. 
 
 
Connection 
After the Slave has been selected, it needs to be connected. 
To connect the Slave, position the mouse-pointer on the MONITOR button (FIGURE 21) and single-
click the left mouse button. 
That Slave is connected and is being monitored.  
The Operator will hear the Slave through the attached Monitoring Speaker, located near the PC. 
 

FIGURE 21:  The MONITOR button    
 
The MONITOR button changes to END MONITOR, during a Monitor connect function. 
 
 
End Monitor 
To end the Monitor function, position the mouse-pointer on the END MONITOR button (FIGURE 
22) and single-click the left mouse button. 
The Monitor function has now ended. 
 

FIGURE 22:  The END MONITOR button    
 
 
The END MONITOR button changes back to MONITOR, once the Monitor function has ended. 
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SECTION 5 – Volume Controls 
 
The Volume control 
The Volume control is a software fader control, used to adjust the volume level of the Monitoring 
Speaker.  The Monitoring Speaker is an external speaker, normally located close to the PC Master in 
front of the PC Master Operator. 
The Volume control is used to adjust listening levels of the following: 

• Incoming Calls 
• Monitoring Function 
• Auxiliary Audio Channels 

 
The Volume and Auxiliary channel (Radio Selected) window (FIGURE 23), is always present in 
the top right-hand corner of the screen. 

                                      
 
 
Adjusting the Volume control 
To adjust the volume, position the mouse-pointer on the Volume pointer knob (FIGURE 24) and 
click and hold down the left mouse button. 

FIGURE 24:  The Volume slider control      
 
The slider lever can now be easily moved across the screen to increase the sound (move it to the right), 
or decrease the sound (move it to the left). 
 
 
Changing Volume on Incoming calls 
During an incoming Call, the Volume control can be changed to adjust the level of incoming speech 
from a calling Slave.  This changes the volume level of the Operators’ Monitoring speaker. 
 
This JACQUES Version 4.28 software has a function automatically built-in, which saves the 
individual volume level for each individual Slave, within the internal database of the PC.   
This compensates for the different microphone sensitivities and gains in each Slave, so as to not 
having to adjust the volume level when they are active. 
This is not an AGC function; it simply stores the volume-preset level of that Slave. 
 
The CH1, CH2 and OFF function boxes will grey-out during incoming calls.  This indicates that they 
cannot be adjusted during this time. 

FIGURE 23: 
The Volume and Radio 
Selected control window 
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SECTION 5 – Volume Controls 
 
The Volume control (continued…) 
 
 
Changing Volume on Monitor Function 
During the Monitor function, the Volume level can be changed to adjust the level of incoming speech 
from a selected Slave.  This changes the volume level of the Operators’ Monitoring speaker. 
Adjust the Monitor function volume level as previous page: Adjusting the Volume control. 
 
The CH1, CH2 and OFF function boxes will grey-out during incoming calls.  This indicates that they 
cannot be adjusted during this time. 
 
 
Changing Volume on Auxiliary Audio Channels 
The Auxiliary channel volume levels can only be changed during the Idle Screen (FIGURE 2, PAGE 
9) or Call Waiting Screen (FIGURE 15, PAGE 15). 
Adjust the volume level of the Operators’ Monitoring speaker, by moving the Volume Pointer control 
up or down accordingly.  See: Adjusting the Volume control, (PREVIOUS PAGE). 
 
Additionally, individual Auxiliary Audio channels can be enabled or disabled by using the Radio 
Selected checkboxes as shown below in FIGURE 25. 
 

 
 
 
 
The Radio Selected window has three function boxes: 
 
1/  CH1 
Left-click inside the empty checkbox.  This will place a tick “!” inside the “CH1” checkbox, 
indicating it has been selected and the Auxiliary Channel #1 is now enabled.   
 
Adjust the volume as necessary.  See: Adjusting the Volume control, (PREVIOUS PAGE). 
 
 
2/  CH2 
Left-click inside the empty checkbox.  This will place a tick “!” inside the “CH2” checkbox, 
indicating it has been selected and the Auxiliary Channel #2 is now enabled.   
 
Adjust the volume as necessary.  See: Adjusting the Volume control, (PREVIOUS PAGE). 
 
3/  OFF 
Left-click inside the empty checkbox.  This will place a tick “!” inside the “OFF” checkbox, 
indicating it has been selected and both Auxiliary Channels are now disabled.   
(FIGURE 25 shows this selection) 

FIGURE 25: 
The Radio Selected (Auxiliary Channel 
selection) checkboxes 
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SECTION 6 – VIEW Menu 
 
VIEW menu 
The View menu contains options that allow the Operator to change some of the Device characteristics 
and the way they are displayed on the screen.   
The View menu is located in the top left-hand corner of the screen. 
Position the mouse-pointer on the View menu and single-click the left mouse button.  The screen will 
now look like FIGURE 26. 
 

FIGURE 26:  The View menu options list 

 
 
VIEW – Masters 
The View - Masters option will display a screen (FIGURE 27), showing a list, in alphabetical order, of 
all the Local Masters as well as all other Masters below it.  It does NOT show any Higher-Level 
Masters.  No user changes can be made to this screen – it is provided to be viewable only. 
 
To select the View Masters menu option, position the mouse-pointer on the View menu.  Single-
click the left mouse button.  Position the mouse-pointer on the View Masters text, so it becomes 
highlighted and then single-click the left mouse button.  The screen will then look like FIGURE 27. 
 

FIGURE 27:  The View Masters menu option 
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SECTION 6 – VIEW Menu 
 
VIEW – Masters (continued…) 
To return to the main Idle screen (FIGURE 2, PAGE 9), position the mouse-pointer on the Close 
button (FIGURE 28) and single-click the left mouse button. 

FIGURE 28:  The Close button    
 

 
VIEW – Miscellaneous Devices  
The View - Miscellaneous option will display a screen (FIGURE 29), showing a list, in alphabetical 
order, of all other Devices that are attached to this Master. 
It displays any Jacques Printer loggers, IO cards, PA Amplifiers and Recording Interfaces.  It does 
NOT display any other JACQUES Masters or Slaves. 
No user changes can be made to this screen – it is provided to be viewable only. 
 
To select the View Miscellaneous Devices menu option (FIGURE 29), position the mouse-pointer 
on the View menu.  Single-click the left mouse button.  Position the mouse-pointer on the View 
Miscellaneous Devices text, so it becomes highlighted and then single-click the left mouse button.   
 

FIGURE 29:  The View Miscellaneous Devices menu option 

 
 
To return to the main Idle screen (FIGURE 2, PAGE 9), position the mouse-pointer on the Close 
button (FIGURE 30) and single-click the left mouse button. 

FIGURE 30:  The Close button   
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SECTION 6 – VIEW Menu 
 

VIEW– Edit Cell Slaves 
**YOU CANNOT EDIT DOOR OR GATE SLAVES – ONLY EDIT CELL SLAVES. 
 
The View – Edit Cell Slaves menu option allows the Operator to change some settings of the 
individual Cell Slaves. 
To select the Edit Cell Slaves menu option, position the mouse-pointer on the View menu.  Single-
click the left mouse button.  Position the mouse-pointer on the Edit Cell Slaves text, so it becomes 
highlighted and then single-click the left mouse button.  The screen will now look like FIGURE 31. 
 
The Edit Cell Slaves menu option can be enabled or disabled.  See the separate Jacques Technical 
Operating Manual for more details.  If it is greyed out, then this option cannot be used. 
 

FIGURE 31:  The Edit Cell Slaves menu option 

 
Tags, Status and Descriptor are NOT changeable by the Operator and can only be changed by a 
Technician from the Setup menu.  (see separate Jacques Electronics Technical Operating Manual) 
Name, Priority, and Radio Options ARE changeable from this screen – see the next few pages. 
 
 
Selecting a Slave 
To begin changing Slave properties, firstly choose the Slave by scrolling through the complete Slave 
list using the ←←←←Prev and Next→→→→ buttons (see FIGURE 32). 

FIGURE 32:  The ←Prev and Next→ buttons    
 

Once a particular Slave is found, various changes can be made to that Slave.
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SECTION 6 – VIEW Menu 
 
VIEW – Edit Cell Slaves - Prisoner Name 
The Prisoner Name box from the View – Edit Cell Slaves menu option, allows the Operator to change 
or update a Slaves’ Device Name.  (For more details on a Name, see PAGE 8.) 
A Name can be any letters, symbols or numbers, or a combination of all three, as long as they are NOT 
longer than 25 characters. 
 
To enter a Name, position the mouse-pointer inside the Prisoner Name textbox (see FIGURE 33).   
Single-click the left mouse button (to activate the cursor inside the box), then type in a Name. 
The selection is automatically saved when you exit the screen. 
 

FIGURE 33:  The Prisoner Name textbox    
 
 
VIEW – Edit Cell Slaves - Priority 
The Priority box from the View – Edit Cell Slaves menu option represents the priority importance of 
the Slave or Device, represented by a number between 0 and 255.  0 being the highest importance, 255 
the lowest.   
To enter a Priority number, position the mouse-pointer inside the Priority textbox (see FIGURE 34).   
Single-click the left mouse button (to activate the cursor inside the box), then type in a Number. 
The selection is automatically saved when you exit the screen. 
 

FIGURE 34:  The Priority textbox    
 
 
VIEW – Edit Cell Slaves - Slave Isolated 
The Slave Isolated checkbox from the View – Edit Cell Slaves menu option allows the Operator to 
determine whether or not that Slave can call a Master. 
If it is isolated (checkbox is ticked), then that Slave cannot talk to a Master, but a Master can Monitor 
that Slave. 
If it is not isolated or De-Isolated, (checkbox is not ticked as shown in FIGURE 35), then that Slave 
calling operates as normal. 
 
To Isolate a Slave: 
Left-click inside the empty checkbox.  This will place a tick “!” inside the “Slave Isolated” 
checkbox, indicating it has been selected.  That Slave is now isolated.  The selection is automatically 
saved when you exit the screen. 
 
To De-Isolate a Slave: 
Left-click inside the ticked checkbox.   
The tick will now be removed (see FIGURE 35) and the Slave is no longer Isolated. 
The selection is automatically saved when you exit the screen. 

FIGURE 35:  The Slave Isolated checkbox (shown as De-Isolated)    
 

The Slave Isolated checkbox option can be enabled or disabled.  See the separate Jacques 
Technical Operating Manual for more details.  If it is greyed out, then this option is disabled. 
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SECTION 6 – VIEW Menu 
 
VIEW – Edit Cell Slaves - Radio Options 
The Radio Options boxes from the View – Edit Cell Slaves menu option are used to control and select 
the Auxiliary audio channels and preset volume levels. 
The Radio Options selection window is shown in FIGURE 36.  
 

FIGURE 36:  The Radio Options selection window    
 
 
VIEW – Edit Cell Slaves – (Radio Options - Channel) 
Use the Channel box to select what Auxiliary Audio channels are going to be available to that Slave. 
There are a maximum number of two Auxiliary Audio channels; Channel 1 and Channel 2.   
They can be individually selected (Enabled) or can both be off (Disabled). 
 
To select (Enable) Auxiliary Audio channels: 
 
This is used in conjunction with the Selectable buttons. 
Left-click inside the “Yes” button (FIGURE 37).  This will place a tick “!” inside the “Selectable - 
Yes” checkbox, indicating it has been selected. 
 

FIGURE 37:  The Selectable �Yes� checkbox enabled   
 
 
When selected, the following options are now available from the Channel menu (FIGURE 38). 
When selected, choose either: 

Channel 1 (Auxiliary Audio Channel 1 enabled) 
Channel 2, (Auxiliary Audio Channel 2 enabled) 
Radio Off (no Auxiliary Audio Channels enabled) 

 

FIGURE 38:  The Auxiliary Audio Channel menu   
 
To enter a Channel (FIGURE 38), position the mouse-pointer on the selected text and single-click the 
left mouse button.   
The selection is automatically saved when you exit the screen. 
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SECTION 6 – VIEW Menu 
 
VIEW – Edit Cell Slaves – (Radio Options - Channel) (continued…) 
 
To NOT select (Disable) Auxiliary Audio channels: 
 
This is used in conjunction with the Selectable buttons. 
Left-click inside the “No” button (see FIGURE 39).   
This will place a tick “!” inside the “Selectable No” button, indicating it has been selected. 
 

FIGURE 39:  The Selectable �No� checkbox   
 
When No has been selected, it effectively disables the AUX.CH button of that Slave front panel. 
This means that the Slave cannot be switched between channels, or both Auxiliary Audio channels are 
off (disabled). 
The selection is automatically saved when you exit the screen. 
 
 
VIEW – Edit Cell Slaves  – (Radio Options - Volume) 
The Volume box does the exact same as the VOL + and VOL – buttons on the Slave front panel, 
except it is adjusted from the JACQUES PC Master software. 
 
To select the Volume level, position the mouse-pointer on the “▼” located on the right hand side of 
the Volume title bar..  Single-click the left mouse button.  The screen now looks like FIGURE 40. 
 

FIGURE 40:  The Volume level options    
 
Position the mouse-pointer on the selected volume level number;  0 (No volume) to 7 (max volume). 
and then single-click the left mouse button.   
The selection is automatically saved when you exit the screen. 
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SECTION 6 – VIEW Menu 
 

VIEW – Edit Cell Slaves – (Radio Options – Max Volume) 
The Max Volume box represents the preset volume level for that Slave.   
The Auxiliary Audio channels’ volume is limited to this level, as it is adjusted from the JACQUES 
Slave’s VOL + and VOL– buttons.  Some Slaves may be located in a quiet area or room, and so may 
be preset to operate at a lower level than others. 
 
To select the Volume level, position the mouse-pointer on the “▼” located on the right hand side of 
the Volume title bar..  Single-click the left mouse button.  The screen now looks like FIGURE 41. 
 

FIGURE 41:  The Max Volume level options    
 
Position the mouse-pointer on the selected volume level number; 0 (No volume) to 7 (max volume). 
and then single-click the left mouse button.  In this example, Max Volume level 1 has been selected. 
The selection is automatically saved when you exit the screen. 
 
 
VIEW – Selection by… 
The View – Selection by… menu options (FIGURE 42) are available for the Operator to select how the 
devices are displayed on the PC screen.  They can be selected in one of three ways: 
 

   
 
 

FIGURE 43:  The Devices election has been by Descriptor, shown by Selection by: Descriptor 
 

 
 

FIGURE 42:  View � Selection by� options:
Selection by Tag

Selection by Descriptor  (FIGURE 43)
Selection by Prisoner Name
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SECTION 6 – VIEW Menu 
 
VIEW – Selection by Tag 
The View – Selection by Tag menu option displays all the Devices, as listed by its Tag. 
See: Device Identification Codes - Tags (PAGE 8). 
 
 
VIEW – Selection by Descriptor 
The View – Selection by Descriptor menu option displays all the Devices, as listed by its Descriptor.  
See: Device Identification Codes - Descriptors (PAGE 8). 
 
 
VIEW – Selection by Prisoner Name 
The View – Selection by Prisoner Name menu option displays all the Devices, as listed by its Name.  
See: Device Identification Codes - Names (PAGE 8). 
 
The Selection by Prisoner Name menu option can be enabled or disabled.   
If this is disabled, this item will be missing from the menu. 
See the separate Jacques Technical Operating Manual for more details.   
 
 
Close 
To return to the main Idle screen (FIGURE 2, PAGE 9), position the mouse-pointer on the Close 
button (see FIGURE 44) and single-click the left mouse button. 
 

FIGURE 44:  The Answer Next button    
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SECTION 7 – OPTIONS Menu 
 
OPTIONS menu 
The Option menu allows the Operator to Activate / Deactivate the Remote switching function. 
 
The Option menu is located in the top left-hand corner of the screen. 
Position the mouse-pointer on the Options menu and single-click the left mouse button.  The screen 
will now look like FIGURE 45. 
 

FIGURE 45:  The Options menu list 

 
 
 
OPTIONS – Activate Remote 
The Options – Activate Remote menu option enables the JACQUES Master into Remote-switching 
mode. 
To select the Activate Remote function, position the mouse-pointer on the Options menu.  
Single-click the left mouse button.  Position the mouse-pointer on the Activate Remote text, so it 
becomes highlighted and then single-click the left mouse button.   
The screen will now look like FIGURE 46. 
 

FIGURE 46:  The Remote Mode enabled screen 
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SECTION 7 – OPTIONS Menu 
 
OPTIONS – De-activate Remote 
To de-activate the Remote switching function, (returning the Master to normal operation after 
Activating the Remote function), position the mouse-pointer on the CANCEL REMOTE button 
(FIGURE 47) and single-click the left mouse button. 

FIGURE 47: The CANCEL REMOTE button    
 
This has now de-activated the Remote function, re-enabling the Master Unit for local operation.   
The screen returns to the Idle screen (FIGURE 2, PAGE 9).  All incoming Calls will now come 
through that Master Unit, as normal operation. 
 
About Remote Switching 
Remote Switching is a feature found in the JACQUES PCC-550M Master Stations.  It allows other 
Masters to control its operation, when in Remote Switching mode. 
For Example: When Remote Switching is enabled on a particular Master, local Operators cannot be 
used to control its operations.  Other Higher-Level Masters now have control of its operations. 
 
When a JACQUES Master Unit is first switched on, it automatically enables itself to operate in 
Remote mode (Remote Activated). 
If the PC Master locks up, or if there are any other faults with that PC unit, then as a safety feature, 
that Master Unit automatically goes into Remote Activated mode. 
 
The Highest-Level Master station cannot be Remoted, as there are NO Master Units above it. 
The Highest-Level Master is permanently in the Remote de-activated mode. 
 
 
OPTIONS – Activate Gate Slaves 
The Options – Activate Gate Slaves menu option allows the Operator to communicate to the Gate and 
Door Slaves, allowing them to be operated in much the same way as other JACQUES Slaves are 
described in this manual. 
When selected, the title Activate Gate Slaves will now change to Deactivate Gate Slaves. 
 
Whenever a Gate or Door Slave calls the JACQUES PCC-550M Master, the call is displayed in the 
Selection by: … window, just as if a normal Cell Slave would appear. 
That Gate or Door Slave can now be answered from the PC Master, as if it were a normal Cell Slave – 
rather only answered from the third party Security Management System. 
 
To disable this function, return to Options menu and select Deactivate Gate Slaves. 
 
 
About Security Management Systems (SMS) software 
JACQUES Electronics Intercom Systems can be easily interfaced and used with other (third party) 
Security Management System software. 
When they are used together and a Gate or Door Slave is calling, then that call can ONLY be 
answered from the other security system software. 
However, the Activate Gate Slaves option will, when selected, enable the Operator to answer the 
Gate and Door Slaves from the JACQUES PC Master unit, just like a normal Cell Slave. 
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SECTION 8 – SETUP Menu 
 
SETUP menu 
The Setup menu option (FIGURE 48) is only to be used by Technicians that are performing critical 
Device setup information.  This includes data and COM-port tests, baud rates, assigning and changing 
Passwords, Tags and other critical adjustments. 
 

FIGURE 48:  The Setup menu list.  (NOT to be used by the Operator) 
 

 
 
The Operator is NOT expected to use this option and so no information is provided in this Manual. 
For more information regarding the Setup menu options and configurations, please refer to the 
separate Jacques Electronics Technical Operating Manual. 
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SECTION 9 – ABOUT Menu 
 
ABOUT menu 
The About menu option (FIGURE 49) displays a window that indicates what software version is 
currently being used, as well as it reading and displaying the current CPU code version.  
 
 

FIGURE 49:  The About menu list 
 

 
 
 
 
Position the mouse-pointer on the About menu, located in the top left-hand corner of the screen and 
single-click the left mouse button.   
The screen will then look like FIGURE 50. 
 
 

  
 
 
 
Close 
To return to the main Idle screen (FIGURE 2, PAGE 9), position the mouse-pointer on the Close 
button (FIGURE 51) and single-click the left mouse button. 
 

FIGURE 51:  The Close button    
 
 

FIGURE 50:  The About window  
 
In this example, this software is version
4.02.  Using CPU code version 46.4.01 
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SECTION 10 – Shortcut Menus 
 
The JACQUES PCC-550M Master also has a range of menus that are used to “quick-select” other 
menu options and user-functions. 
This Section describes these menus and they are referred to as Shortcut menus. 
 
DEVICE shortcut menu 
The Device shortcut menu is used as a shortcut to operate a selection of Device functions.  
It is designed to make these functions quicker and easier to use by the Operator. 
To display the Device shortcut menu (FIGURE 52), simply place the mouse pointer anywhere within 
the white area of the Idle screen (FIGURE 53) and single-click the right mouse button. 
 

FIGURE 52:  The Device shortcut menu list    
 

FIGURE 53: 
Right-click anywhere inside the white part of the Idle screen, to display the Device shortcut 
menu 
 

 
 

Right-click anywhere 
inside the white area. 
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SECTION 10 – Shortcut Menus 
 
DEVICE shortcut menu - Edit Device 
**YOU CANNOT EDIT DOOR OR GATE SLAVES – ONLY EDIT CELL SLAVES. 
 
The Edit Device option from the Device shortcut menu is the same as the View – Edit Cell Slaves 
option (PAGE 25). 
By selecting this option, it will open the Edit Cell Slaves screen, as shown as FIGURE 31, PAGE 25. 
 
Step 1/ 
Select the required Device, by clicking on it from the Selection by:… list.  The Device is now 
highlighted. 
 
Step 2/ 
Right-click the mouse (FIGURE 53, previous page) to display the Device shortcut menu. 
Click on the Edit Device option from the shortcut menu. 
The screen will now look like FIGURE 31, PAGE 25. 
 
The Edit Cell Slaves menu option can be enabled or disabled.  See the separate Jacques Technical 
Operating Manual for more details.  If it is greyed out, then this option is disabled. 
 
 
 
DEVICE shortcut menu - Isolate Device 
The Isolate Device option from the Device shortcut menu is the same as the View – Edit Cell 
Slaves – Slave Isolated option (PAGE 25).  By selecting this option, it will automatically isolate 
that Slave or Device. 
 
To Isolate a Device. 
Step 1/ 
Select the required Device, by clicking on it from the Selection by:… list.  The Device is now 
highlighted. 
 
Step 2/ 
Right-click the mouse (FIGURE 53, previous page) to display the Device shortcut menu. 
Click on the Isolate Device option from the shortcut menu. 
That Device is now isolated.  It is confirmed by the text now written in red and the words (Isolated) 
next to it. 
 
To De-isolate an Isolated Device when selected. 
Step 1/ 
Select the required Device, by clicking on it from the Selection by:… list.  The Device is now 
highlighted. 
 
Step 2/ 
Right-click the mouse (FIGURE 53, previous page) to display the Device shortcut menu. 
Click on the Unisolate Device option from the shortcut menu. 
That Device is now De-isolated, working again as normal. 
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SECTION 10 – Shortcut Menus 
 
DEVICE shortcut menu - Call Device 
The Call Device option from the Device shortcut menu is the same as pressing the CONNECT button 
from the Call-Waiting screen (FIGURE 15, PAGE 15), used to call a Device. 
 
Step 1/ 
Select the required Device, by clicking on it from the Selection by:… list.  The Device is now 
highlighted. 
 
Step 2/ 
Right-click the mouse (FIGURE 53, PAGE 35) to display the Device shortcut menu. 
Click on the Call Device option from the shortcut menu. 
 
The PC Master is now calling the Device selected. 
 
 
 
DEVICE shortcut menu - Monitor Device 
The Monitor Device option from the Device shortcut menu is the same as pressing the MONITOR 
button from the Idle screen (FIGURE 2, PAGE 9), used to Monitor a Slave or Device. 
 
Step 1/ 
Select the required Slave or Device by clicking on it from the Selection by:… list.   
The Device is now highlighted. 
 
Step 2/ 
Right-click the mouse (FIGURE 53, PAGE 35) to display the Device shortcut menu. 
Click on the Monitor Device option from the shortcut menu. 
 
That Device selected, is now being Monitored. 
 
 
 
DEVICE shortcut menu - Activate Remote 
The Activate Remote option from the Device shortcut menu is the same as the Options – Activate 
Remote option.  By selecting this option, it will activate the Remote Switching function.   
See: OPTIONS – Activate Remote (PAGE 31). 
 
Step 1/ 
Right-click the mouse (FIGURE 53, PAGE 35) to display the Device shortcut menu. 
 
 
Step 2/ 
Click on the Activate Remote option from the shortcut menu. 
 
The PC Master is now in Remote Mode and the screen will now look like FIGURE 45, PAGE 29. 
 
To cancel Remote mode, click on the CANCEL REMOTE button. 
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SECTION 10 – Shortcut Menus 
 
MASTER shortcut menu 
The Master shortcut menu is used as a shortcut to operate a selection of Master functions. 
It is designed to make these functions quicker and easier to use by the Operator. 
 
To display the Master shortcut menu (FIGURE 54), right-click the selected Master from the 
Selection by:… list as shown in FIGURE 55. 

FIGURE 54:  The Master shortcut menu list    
 

FIGURE 55:  Right-click the required Master, to display the Master shortcut menu 
 

 
 
 
MASTER shortcut menu - Call Device 
The Call Device option from the Master shortcut menu is the same as pressing the CONNECT button 
from the Call-Waiting screen (FIGURE 15, PAGE 15), used to call another Master. 
 
Step 1/ 
Select the required Master, by clicking on it from the Selection by:… list.  The Master is now 
highlighted. 
 
Step 2/ 
Right-click the mouse (FIGURE 55) to display the Master shortcut menu. 
 
Step 3/ 
Click on the Call Device option from the shortcut menu.  The PC Master is now calling another 
Master selected. 
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SECTION 10 – Shortcut Menus 
 
MASTER shortcut menu – Remote Other Master 
The Remote Other Master option from the Master shortcut menu will remote other Masters in the 
system. 
 
Step 1/ 
Select the Master to be Remoted, by clicking on it from the Selection by:… list.  The Master is now 
highlighted. 
 
Step 2/ 
Right-click the mouse (FIGURE 55, previous page) to display the Master shortcut menu. 
 
Step 3/ 
Click on the Remote Other Master option from the shortcut menu. 
The selected PC Master is now in Remote mode – so any incoming calls are now diverted through it. 
 
 
MASTER shortcut menu – Activate Remote 
The Activate Remote option from the Master shortcut menu is the same as selecting the Activate 
Remote button from the Options menu.  See OPTIONS – Activate Remote (PAGE 31). 
 
Step 1/ 
Select the active Master from the Selection by:… list.  The Master is now highlighted. 
 
Step 2/ 
Right-click the mouse (FIGURE 55, previous page) to display the Master shortcut menu. 
 
Step 3/ 
Click on the Activate Remote option from the shortcut menu. 
The PC Master is now in Remote Mode.  All incoming Calls will now divert to the next Master up and 
the screen will now look like FIGURE 56. 
 

FIGURE 56:  The Remote Mode activated screen 
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For further details about JACQUES Intercom features and designs, 
please visit the JACQUES website at: www.jacques.com.au 
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